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Draw with adjustable perspective grids
• Choose isometric, oblique, or perspective 
projection grids
• Choose 1, 2 or 3-point perspective
• Adjust foreshortening, horizon and distortion
• Adjust grid spacing
• Snap tools to grid
• Faces and objects created with Perspective can 
update automatically to match the background grid 
when the grid changes or artwork is moved

Draw with perspective line, face, object and 
grid tools
• Seven line and face drawing tools in the Perspec-
tive drawing tool group in the Illustrator toolbox
• A grid tool that creates horizontal or vertical 
planes as artwork
• Cube and cylinder object drawing tools
• All face and object tools support numeric input

Project flat artwork on horizontal or 
vertical faces
• Project any vector artwork - including outlined 
text - in perspective with the Projection palette
• Choose from top/bottom, front or side faces
• Instantly flatten projected faces for editing

Remember, Illustrator and Perspective are not real 
3D modeling tools. But with very little effort, 
you can create the illusion of 3D without leaving 
Illustrator. To better understand the principles 
behind Perspective and 3D representational drawing, 
please review Perspective and 3D representational 
drawing (p.9)

Welcome to Hot Door Perspective, the first plug-in 
to offer true perspective, oblique, and isometric 
drawing within Adobe Illustrator CS or CS2! 
Perspective provides three indispensable levels of 
control to help you create beautifully real 
compositions with amazing speed: 

About Hot Door PerspectiveUpgrading from Perspective 1

What’s new in Perspective 2
• Illustrator CS and CS2 compatibility
• Improved realistic projection methods
• Numeric adjustment of horizontal vanishing points
• Option to turn on/off foreshortening for isometric objects 
(foreshortening value is fixed at 81%)

Opening documents created with Perspective 1
Perspective 2 includes new drawing methods for enhanced 
realistic projections. If you open a document containing 
objects created with Perspective 1, you will be asked to 
convert the document. If you choose Convert, the objects will 
update to match new projection methods and the results may 
not be desirable. If you choose Do Not Convert, the Perspec-
tive objects will appear unaffected, but they will 
no longer be live or responsive to grid changes.



6 7

Installing Hot Door Perspective (cont.)

If you have purchased a full version of Perspective, 
enter your Perspective serial number (with a format 
XXXX-X-X-XXX-XX-XXXXX) and click OK. Illustrator 
will open and you will see some of the tools 
belonging to Perspective in the toolbox. The 
Perspective icons have green point markings.

For demo use:
If you wish to use the demo version of Perspective, 
click the Demo button on the Perspective Personal-
ization dialog box that appears when you launch 
Illustrator. If the Perspective demo is installed, you 
will not be able to adjust the Perspective grid and 
projection settings. Any Perspective artwork will be 
created in a locked 2-point perspective view. The 
Perspective demo will not affect artwork created with 
the standard Adobe Illustrator tools.

If you wish to purchase the full version of Perspec-
tive, click the Purchase button on the Perspective 
Personalization dialog box to automatically launch 
the Hot Door Web site and online store with your 
Web browser software. When you purchase the full 
version of Perspective, you will be supplied with a 
serial number that will convert your Perspective 
demo to a full version. 

To uninstall the demo or full version of Perspective, 
simply remove the plug-in from the Adobe Illustrator 
> Plug-ins > Tools folder.

Installing Hot Door Perspective

On Windows - Double-click Install Hot Door 
Perspective 2. 

On Mac - Double-click Perspective2.dmg. This will 
mount the Perspective disk image. 

1. Follow the on-screen instructions to install the file 
named Perspective into the Adobe Illustrator > Plug-ins > 
Tools folder. If you have an old version, it will be replaced.

2. When you launch the Adobe Illustrator application 
again, a Perspective Activation dialog will appear. First 
enter your new Perspective 2 serial number in the 
Activation dialog. Click OK.

For Upgrades only
3. If you have entered a Perspective 2 upgrade number, 
the Perspective 2 Upgrade Confirmation dialog will 
appear. Enter your Perspective 1 serial number to 
confirm the upgrade and complete activation.
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Registration and technical support

Registration:
If you have not ordered from Hot Door directly, please 
complete the registration form at
http://www.hotdoor.com/register.html

Technical support online:
As a registered user, you are entitled to free email or 
phone technical support. Free email technical support is 
available at perspective@hotdoor.com.

Online detailed FAQ, technical support, and tutorial:
Visit http://www.hotdoor.com to access the Perspective page.

Technical support by phone: 949-464-0300 
Phone inquiries are always welcome and service is prompt and 
professional. 

Understanding Perspective and 
3D representational drawing
Adobe Illustrator is a very powerful vector-based 
drawing environment, but it has typically been 
limited to 2D graphics work. Most artwork 
created within Illustrator is visually flat 
(orthographic projection), including typography, 
logo design, Web graphics, etc. Representing any 
3D detail is a real challenge in Illustrator and other 
drawing programs – even for dexterous users with 
a background in design and illustration.  

How does Perspective differ from a 3D 
modeling program?
Unfortunately, a 3D modeling program can be very 
complex and expensive. 3D worlds require a new 
understanding of space, and many projects don’t 
require three dimensional data or intensive modeling 
manipulation. Now you can use Perspective to create 
the illusion of 3D with clean vector graphics in the 
familiar and powerful 2D world of Adobe Illustrator.

Hot Door Perspective is integrated right into Illustra-
tor, but does not introduce a new 3D world. Perspec-
tive only represents 3D objects with 2D artwork. 
Perspective 2D objects cannot be freely rotated, 
surface mapped, or otherwise manipulated as solids. 
However, Perspective artwork is fully editable like 
other shapes inside Illustrator. Live Perspective 
objects are also internally linked to flat orthographic 
shapes so you can transform artwork to and from 2D 
or dimensional compositions with ease.
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Understanding Perspective and 
3D representational drawing (cont.)

Hot Door Perspective relies on geometrical principles that 
have been used to create realism in art for many centuries. 
Please review how the following terms are used in Hot Door 
Perspective to represent 3D in a 2D world:

Projection is a method of geometrically translating the 
artwork on the picture plane to rotated planes for more 
realistic and useful interpretation. Your artwork is typically 
created in flat, orthographic projection on the picture plane 
- or artboard - of Adobe Illustrator. Hot Door Perspective 
adds three methods of projection: isometric, oblique, and 
perspective.

Faces are polygons (closed paths) that represent artwork 
that has been projected on to a horizontal or vertical 
plane. Except for the front faces in one point perspective 
or oblique projection, all object faces recede at parallel 
angles or converge toward vanishing points. For simplicity, 
the term “face” is used in Hot Door Perspective instead of 
“plane.”

Horizon represents the eye-level of the viewer.

Vanishing or receding lines represent the edges of an 
object which appear to recede in space at an angle or toward 
a vanishing point. 

Vanishing points in 1 or 2-point perspective are the places 
on the horizon at which the objects’ vanishing (receding) 
lines converge. In 3-point perspective, the third point is 
a vertical vanishing point that emphasizes the height of 
objects.

Foreshortening is a forced reduction of the depth of an 
object to make it appear to recede in isometric and oblique 
projections.

horizon linevanishing point

van
ishing lines face

flat view
projects into face

Understanding Perspective and 
3D representational drawing (cont.)

Perspective uses three methods of 3D “illusion” 
which can be fine-tuned for visual preference.

Isometric projection is a simple method of 
creating 3D object representations which can be 
directly measured. Parallel receding lines define the 
edges of all sides, and they are typically drawn at 
30° to the horizontal. Dimensions are often made 
along the isometric lines for making technical ref-
erence drawings. Note: You must purchase Hot Door 
CADtools to be able to pull dimensions off of objects 
created with Hot Door Perspective.



12 13

Oblique projection is commonly used to display object front 
faces in their true shape, while the parallel receding lines 
along the top, bottom, or sides are at a convenient angle 
to the horizontal (such as 45°). Dimensions are often made 
along oblique objects to create technical reference drawings. 
Note: You must purchase Hot Door CADtools to be able to pull 
dimensions off of objects created with Hot Door Perspective.

In both oblique and isometric projections, foreshortening can 
be applied to enhance the realistic appearance of objects. If 
foreshortening is applied, however, measurements cannot be 
taken directly from the artwork.

Understanding Perspective and 
3D representational drawing (cont.)

Understanding Perspective and 
3D representational drawing (cont.)

Perspective projection is the most realistic and 
popular method of representing 3D. Perspective 
projection can offer great flexibility in manipulating 
the appearance of objects. Different types of 
perspective provide unique effects suitable for 
different applications and industries.

One point
In one point perspective, the front face of an 
object retains its true shape while the top, 
bottom, and side faces recede to one point 
along a line that represents your eye level 
(horizon). This method is often used for high-
impact dimensional graphics and rendering of 
architectural spaces.
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Two point
Two point perspective is the most common perspective 
projection in which all faces of an object recede to one 
of two points along the horizon line. All vertical edges 
within the object remain perpendicular to the horizon. 
The receding effect can be increased or diminished by 
controlling the space between the vanishing points 
(distortion).

Understanding Perspective and 
3D representational drawing (cont.)

Understanding Perspective and 
3D representational drawing (cont.)

Three point
Three point perspective can create the most 
realistic objects by introducing a vertical 
vanishing point that can be moved from 
center to cause vertical lines to recede above 
or below the horizon. Additional distortion 
effects can be created by moving the vertical 
vanishing point horizontally. Three-point 
perspective is also used to create more 
dramatic “bird’s eye” or “worm’s” eye views 
of objects or environments.
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Overview of the Perspective interface

Displaying Perspective palettes
After you have properly installed Perspective and launched 
Adobe Illustrator, you will notice three new palettes available 
within lllustrator. These palettes can be opened by choosing 
one of the selections under Window > Perspective. 

Perspective Document palette helps you adjust the projection 
style of the background grid. Perspective tools will automati-
cally snap, constrain and conform to the background grid. 
Choose from isometric, oblique, or perspective environments 
using 1, 2 or 3 points. Sliders in the palette provide smooth 
control over horizon location and distortion. If “Create Live 
Objects” is checked, faces and objects can automatically up-
date to match the background grid when the grid is changed 
or when the artwork is moved. Live update is most useful for 
creating basic structural objects in your document and fine-
tuning projection settings for your composition.

Perspective Grid palette provides control over the appearance 
and snapping behavior of the Perspective background grid and 
Perspective faces.

Perspective Object palette allows you to convert flat (ortho-
graphic) artwork into dimensional artwork that reshapes to 
a top or bottom horizontal plane or a front or side vertical 
plane. Perspective remembers the original shape so you can 
instantly flatten it for detailed editing or CAD output. The 
Update button in the Perspective Object palette will force live 
Perspective artwork to reshape to match the grid.

Selecting Perspective tools
Perspective also adds new drawing tool groups to the toolbox 
of Adobe Illustrator. Perspective tool icons are distinguished 
by their green point markings. Note: Excluding the grid tool, 
all Perspective drawing tools support numeric input  - click once 
on the document to enter values for faces or objects. 

Setting Perspective grids

Setting up the grid appearance
Hot Door Perspective allows you to view, manipulate, and snap 
to a background projection grid. 

First, open Window > 
Perspective > Show 
Perspective Grids and 
check Show grid. The grid 
is document-based so you 
can open multiple documents 
with different grid styles.

Then set up your grid 
appearance by setting Grid 
color, spacing, snapping, and 
snap tolerance. Snap toler-
ance will also affect Perspective face snapping. Click Show 
horizontal lines to show additional guides in 1 pt perspective. 
Click Show vertical lines to show additional guides in 1 pt or 
2 pt perspective. Move the spacing slider toward “more” to 
increase the space between the grid lines. Move the spacing 
slider toward “less” to decrease 
the space between the grid 
lines. This slider also controls 
the spacing between the lines 
drawn by the Perspective grid 
tool.

Artwork drawn with Perspec-
tive drawing tools or projected 
with the Perspective object 
palette will automatically 
conform to the grid. Note: 
Only Perspective drawing tools 
will snap or constrain to the 
Perspective background grid.

Perspective provides three 
projection styles for the 
Perspective grid. Choose 
Window > Perspective > 
Show Perspective Document. 



18 19

Setting Perspective grids (cont.)

The Perspective Document settings are saved with each docu-
ment. If you want to save specific settings, you may want to 
save “template” files with desired settings and useful names. 
Draw a simple Perspective cube in order to save the document 
grid settings. 

Creating Live Objects
Live objects were designed to help you create basic structural 
elements and choose projection settings prior to making a 
detailed illustration. If you create Perspective artwork with 
Create live objects checked, faces and objects will be inter-
nally linked to the grid and update with any grid changes. 
(If the artwork is moved, you must force the live artwork 
to update by clicking the Update button in the Perspective 
Objects palette.)

If not used properly, live objects can alter your artwork in un-
predictable ways. You should consider the following guidelines 
for more effective use:

1) Check live objects to make Perspective objects that help 
you view and adjust your projection settings before making 
your illustration.
2) Check live objects if you want to project “flat” artwork and 
be able to reflatten it later. Flattened artwork is easy to edit 
and reproject. 
3) Check live objects if you are working with artwork that ex-
ists on one of three faces of a cube. Outlined text also works 
well as live objects within these faces.

If you have already created live objects and wish to remove 
their internal links to the grid, then expand the artwork us-
ing the Expand button in the Perspective Objects palette.

If you want to reshape live Perspective objects, you should 
first flatten them. If you prefer to edit the objects in their 
projected state, you should always expand the artwork with 
the Expand button in the Perspective Objects palette.

Setting Perspective grids (cont.)

Setting projection
The three projection styles 
can be changed and live 
Perspective artwork is 
updated to follow. 
However, depending on 
its position and the 
intensity of distortion, 
some artwork may not 
appear correct after 
updating. For best results, 
select and adjust a final 
projection style before 
creating a detailed compo-
sition. You may want 
to use a simple “test” cube 
to set projection styles.

Isometric projection 
creates 3D object 
representations which can 
be directly measured. 
Parallel receding lines 
define the edges of all sides. You can create a better illusion 
of Perspective by checking Foreshortened, resulting in the 
foreshortening of isometric receding lines. 

Note: In isometric projection, top 
faces are drawn as though you 
are above the object. Therefore, if 
you change projection types after 
creating isometric objects, make 
sure that your horizon is located 
above the artwork.
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Setting Perspective grids (cont.)

Oblique projection 
creates 3D object 
representations in 
which the front faces 
are displayed as their 
true shape without 
projection.  Use 
the slider to apply 
a percentage scale 
of foreshortening. 
When receding lines 
are foreshortened 
at 50%, the drawing 
is called a cabinet 
drawing. All faces can 
be directly measured if 
foreshortening is not 
applied (set 100%).

Enter a value for 
the angle of the 
receding lines. 
Oblique projections are commonly made at 45° with no 
foreshortening (cavalier projection).

Note: In oblique projection, top faces are drawn as though 
you are above the object. Therefore, if you change projection 
types after creating oblique objects, make sure that your 
horizon is located above the artwork.

Setting Perspective grids (cont.)

Perspective projection 
creates more realistic 3D 
object representations. 
You can also use the slid-
ers to create distortions 
to emphasize object 
dimensions.  

1 point - Choose 
1 pt to create more 
dramatic dimensional 
effects. Except for 
front faces, faces 
recede toward one 
movable vanishing 
point. 
Horizon: Slide to 
move the vanishing 
point lower or higher 
on the document.
Position: Slide to 
move the vanishing 
point to the left or 
right of the center of the document.
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2 point - Choose 
2 pt to create realistic 
objects. Horizon: Slide 
to move the vanishing 
points lower or higher 
on the document.
H Distort: Slide toward 
high to move the 
vanishing points closer 
together, emphasizing 
the perspective effect. 
Slide toward low to 
reduce the perspective 
effect.  For numeric 
control of actual 
spacing between 
vanishing points, 
enter a value into 
the VP separation 
field.

Setting Perspective grids (cont.)

3 point - Choose 
3 pt to create the 
most realistic objects 
and fine-tune the 
perspective effect. 
You can create very 
dramatic effects 
by controlling the 
location of the third 
vanishing point.

Horizon: Slide 
to move the two 
horizontal vanishing 
points lower or higher 
on the document.

H Distort: Slide 
toward high to move 
the horizontal van-
ishing points closer 
together, emphasiz-
ing the perspective 
effect. Slide toward low to reduce the perspec-
tive effect. For numeric control of actual spacing 
between vanishing points, enter a value into the VP 
separation field.

V Distort - bottom/top: Slide toward bottom to move 
the vertical vanishing point toward the bottom 
of the document, creating a “bird’s eye 
view.” Slide toward top to move the verti-
cal vanishing point toward the top of the 
document, creating a “worm’s eye view.”

V Distort - left/right: Slide toward left to 
move the vertical vanishing point toward 
the left side of the document. Slide 
toward right to move the vertical 
vanishing point toward the right side 
of the document.

Setting Perspective grids (cont.)

object above horizon

object below horizon

object below very high horizon
and vertical distortion toward
the bottom left
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Drawing with Perspective tools

Perspective allows you to create lines, faces, and 
objects that constrain to the grid. By checking 
Create live objects in the Perspective Document 
palette, Perspective faces and objects can also 
update to conform to the current Perspective 
background grid. To update Perspective artwork, 
you may need to click the Update button in the 
Perspective Objects palette. If you don’t want 
objects to reshape to grid changes, uncheck Create 
live objects before you begin drawing, or expand 
live objects with the Expand button in the Perspec-
tive Objects palette. 

Perspective Line tool - The Perspective 
Line tool allows you to drag and constrain 
a line to recede toward the nearest vanish-

ing point. You can easily create shapes that appear 
as vertical or horizontal planes in 3D space. Note: 
Lines created with the Perspective Line tool will not 
update with grid changes.

Select the line tool and position the cursor where 
you want the beginning of the line to appear. Click 
and drag to position the line, then release the 
mouse button to create the line. Hold down the 
shift key while dragging to create a receding line 
toward to the nearest vanishing point.

Drawing with Perspective tools (cont.)

To create polygons with the line tool, first click and 
drag to create a line. To create a new line joined at 
an endpoint, position your mouse over the endpoint. 
When the (      ) cursor appears, begin dragging again. 
Release the mouse button when you have positioned 
the line and continue the process as needed. If you 
want to close the path, click and drag the final line 
until the cursor is over the first anchor point of the 
polygon. When the (      ) cursor appears, release the 
mouse button and the polygon will close itself.

Use the shift key while dragging to constrain the line 
toward a vanishing point!

All Perspective drawing tools support numeric input by 
clicking once on the document. To numerically create a 
line, click once on the document with the Perspective 
Line tool.

Choose a length and specific angle or direction toward 
a vanishing point. The units of length will default to 
the units set in your Adobe Illustrator preferences, but 
you can use any units supported by Illustrator.
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Drawing with Perspective tools (cont.)

Perspective Rectangle, Centered Rectangle, Rounded Rect-
angle, Centered Rounded Rectangle, Ellipse, and Centered 
Ellipse tools - these Perspective face tools allow you to drag 
and constrain faces that recede toward the nearest vanishing 
point.

Select the tool and position the cursor where you want a 
corner (or center for centered tools) to appear. Click and drag 
from one edge of the face to the opposite edge. Hold down the 
shift key while dragging to create a square or circular face. 
Use the following keys to create vertical or horizontal faces:

Front vertical faces (left sides of objects): 
No modifier key

Side vertical faces (right sides of objects): 
Hold down the command key (Mac) or con-
trol key (Windows) after you begin dragging 
with the tool.

Horizontal faces (top or bottom sides of 
objects): use the alt/option key after you be-
gin dragging with the tool. If you are above 
the horizon in perspective projection, you 
will draw a bottom face. If you are below the 
horizon in perspective projection, you will 
draw a top face.

Note: To numerically create a face, click once on the document 
with the tool.

Tip: The cube icon in the Perspective 
Objects palette indicates the type of 
face during and after you draw!

Drawing with Perspective tools (cont.)

Using the Perspective Objects palette to 
identify faces while drawing -  The cube icon 
in the Perspective Objects palette indicates the 
face you are drawing. If you select Perspective 
artwork, the icon also indicates if the face is a 
front, side, or top projection.

Using the cursor to snap and align faces -  If you first click 
the corner point of a face to begin dragging an adjacent face, 
you will be able to see helpful cursor hints for accurate snap-
ping and alignment. For example, when the top corner of the 
side face aligns with the top of the front face, the cursor hint 
will appear – “aligns with front.”

Likewise, when you start dragging a top face from the corner 
point of a front or side, you will be able to see helpful cursor 
hints for aligning the top. Note: when your cursor changes to        
    , you know you are over a corner point.

The tolerance for face snapping is the same as the snap to grid 
tolerance set in the Perspective Grids palette.

Tips for drawing ellipses -  When drawing 
ellipses, keep in mind that your cursor will 
be located at the corner of the bounding box 
of the ellipse - not at the edge of the ellipse 
itself. 

aligns with front aligns with side
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Drawing with Perspective tools (cont.)

Perspective Grid tool - First, use the Grid options 
panel of the Perspective document palette to set the 
desired spacing of the Perspective background grid. 

Then click and drag a grid “face” as you would draw a Perspec-
tive rectangle.  Use the same Perspective face modifier keys 
to create vertical or horizontal grid faces. The grid face will 
appear containing grid artwork that follows the grid settings. 
The spacing between the grid lines follows the grid spacing set 
in the Perspective Grids palette. When the slider is at the far 
right (more), the grid spacing will be 2 inches. When the slider 
is at the far left (less), the grid spacing will be .125 inches. 

Note: The grid tool does 
not support numeric 
input – it uses the 
current grid settings to 
create grid artwork. 
Like other faces in 
Perspective, “live” grid 
faces update to match 
the Perspective back-
ground grid. Similarly, 
you should first expand 
the grid artwork before resizing or editing it with Illustrator 
tools. Use the Expand button in the Perspective Objects palette 
to release all internal links to the grid.

a grid can be drawn as a front, side, or top face

home point

cubes can be started 
as front, side or top 
faces by holding 
down the appropriate 
modifier keys

drag along 
the receding line 
that connects the 
home point

Drawing with Perspective tools (cont.)

Perspective Cube tool - First, click and 
drag a front, side, or top face just as you 
would draw any other Perspective face. 

After releasing the mouse, immediately drag toward 
the vanishing point without clicking to preview the 
cube’s depth. When the desired depth is reached, 
click the mouse to create it. (You do not need to 
hold down any modifier keys while dragging the 
depth of the cube.) 
Note: For more accurate drawing, drag along the 
receding line between the home point and the vanish-
ing point. The home point is the central point loca-
tion that is shared by all faces of a cube. Cubes are 
automatically grouped when created. Remember to 
finish creating the cube depth before deleting or 
choosing another tool.

Single-click on the document to create a cube nu-
merically. The cube’s home point will be placed at 
your click point. If the click point is near the hori-
zon, the cube may draw above or below the horizon, 
depending on its size and click point location.

Note: For best results, avoid drawing cubes directly 
over the horizon or at extremely large sizes. After 
creating live cubes, also avoid moving them to the op-
posite side of the horizon where top/bottom faces will 
project incorrectly.
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Drawing with Perspective tools (cont.)

Perspective Cylinder tool - First, click and drag a 
front, side, or top face just as you would draw a Per-
spective face. After releasing the mouse, immediately 

drag toward the vanishing point without clicking to preview the 
cylinder’s depth. When the desired depth is reached, click the 
mouse to create it. (You do not need to hold down any modi-
fier keys while dragging the depth of the cube.) 
Note: For more accurate drawing, drag along the receding line 
that is created between one of the top or bottom points of the 
ellipse and the vanishing point.  The exact drag point (top or 
bottom) differs based upon how the cylinder was created. Cyl-
inders are automatically grouped when created. Remember to 
finish creating the cylinder depth before deleting or choos-
ing another tool.

Single-click on the document to create a cylinder numerically. 
The cylinder face’s center point will be placed at your click 
point.

drag along 
the receding line that 
connects the top or 
bottom ellipse point 
to the vanishing point

cylinders can be start-
ed as front, side or 
top faces by holding 
down the appropriate 
modifier keys

Outlining Perspective artwork

Add visual definition to your composition by outlining the 
edges. Select the artwork and click the Outline button in the 
Perspective Objects palette.
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Projecting flat artwork as faces

Perspective allows you to instantly project “flat” 
artwork as faces that automatically conform to 
the current Perspective background grid settings. 
You can also change the face to which the artwork 
is projected by simply choosing an alternate face 
from the Perspective Objects palette. Note: Artwork 
that is grouped and projected will project on the 
same face. Any vector artwork can be projected 
except for horizontal and vertical lines.

Choose Window > Perspective > Show Perspec-
tive Objects. Note: You may want to copy your 
artwork or save a copy of your document before you 
start projecting artwork – especially if you need to 
keep your flat artwork. 

Project a front (left) face 
First, select the artwork that 
you want to project as a front 
(left) face. If you want multiple 
shapes to project on the same 
face, group the artwork. With the 
artwork selected, click on the 
left face of the cube icon in the 
Perspective Objects palette. 

Projecting flat artwork as faces (cont.)

Project a side (right) face - First, select the 
artwork that you want to project as a side (right) 
face. If you want multiple shapes to project on 
the same face, group the artwork. With the art-
work selected, click on the right face of the cube 
icon in the Perspective Objects palette.

Project a top face - First, select the artwork that 
you want to project as a top face. If you want 
multiple shapes to project on the same face, 
group the artwork. With the artwork selected, 
click on the top face of the cube icon in the 
Perspective Objects palette.

Any shape that has been projected can be flattened to flat 
artwork again if it was created with Create Live Objects checked 
in the Perspective Document palette. To flatten a shape, select it 
and click the Flatten button in the Perspective Objects palette.

Note: If you move live artwork after it is projected, it will 
not update automatically. Click the Update button in the 
Perspective Objects palette to force live artwork to update.
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Projecting flat artwork as faces (cont.)

Tips on projecting
Grouping - If you want the artwork to project on the same 
plane, remember to group the artwork before projecting. After 
projecting all faces of an object, you may want to group them 
as well.

Ungrouped artwork

Grouped artwork

Note: If you ungroup artwork that was projected as a group, the 
artwork will not be live or able to flatten.

Arranging 3 views - If you create 2 or 3 views to project, ar-
range the artwork prior to projection as shown below: 

If you are above the horizon:

If you are below the horizon:

If you want to use the same artwork for front, side, or top/
bottom faces, simply copy and paste the flat artwork in the 
arrangement as shown above.

bottom

front side

top

front side

projected

projected

projected

projected

top

bottom

flattened

Flattening or expanding artwork

Flatten to edit
If you have created Perspective artwork with Create Live Objects 
checked in the Perspective Document palette, you can flatten 
the faces and objects (orthographic projections) for easy, 
accurate editing with Illustrator tools.

First, select the face(s) or object(s) you need to edit. Then click 
the Flatten button in the Perspective Objects palette. After 
editing, reproject the artwork as faces using the cube icon in 
the Perspective Object palette. Note: If you move the flattened 
artwork, it will not reproject in the same location. 

Note: If you reshape a “live” projected face, the artwork will 
no longer correctly adjust to the Perspective background grid 
or flatten correctly. 

If you select and flatten an entire object made of Perspective 
faces, the faces will flatten in the following arrangement, 
with the top and sides adjacent to the front:
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Flattening or expanding artwork (cont.)

Flatten to measure
Perspective artwork can be flattened, measured and saved, 
exported, or printed for CAD applications. You may want to 
save a separate copy of the file with Perspective objects prior 
to flattening and measuring. The flattened artwork can be 
measured and dimensioned in scale with the Hot Door CADtools 
plug-in, sold separately.

Expand to remove links to Perspective grid
If you want to use Illustrator tools to edit live Perspective 
objects without flattening, you should select and expand the 
artwork to avoid unexpected reshaping to the Perspective grid. 
Use the Expand button located in the Perspective Objects 
palette to remove all internal links between the selected 
artwork and Perspective grid. 

expanded

- same artwork, 
but no longer 
linked to grid

home point 
for cube

Editing Perspective artwork

“Live” Perspective artwork will automatically adjust to changes 
in the grid if the artwork was created with Create Live Objects 
checked. 

Moving artwork
Perspective artwork adjusts to the Perspective grid settings in 
all directions. There is only one point called the home point on 
every face or object that remains stationary. When you move a 
“live” Perspective face or object, drag its home point to the new 
location for best results. Note: Perspective lines do not have a 
home point and do not update.

If you move live artwork after it is projected, it will not update 
automatically. Click the Update button in the Perspective Ob-
jects palette to force live artwork to update.

Note: If the artwork or background grid is moved so that a 
top or bottom face of an object is no longer visible, the faces 
will not update correctly. If the artwork or background grid 
is moved so that the artwork appears extremely distorted, 
the artwork may not be able to flatten to its original state.

Editing artwork
If you edit or reshape Perspective artwork in its projected state, 
it may no longer update correctly. If you plan to edit artwork 
when it is projected, you should either 1) flatten and edit the 
flat artwork, then reproject faces or 2) expand the artwork in 
its projected state to prevent unpredictable results when the 
grid updates. Use the Expand button in the Perspective Objects 
palette to remove all internal links to the grid.

Each face contains this 
home point. You can best 
remember the home point 
of each face by imagining 
all the faces put together 
as a cube.
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Perspective drawing tips

Using bitmap or raster artwork
Hot Door Perspective does not currently support 
projection of bitmap or raster artwork. 

Quickly setting Perspective grids
Before setting your Perspective grids, draw a Perspective 
cube with Create Live Objects checked. Then choose and 
adjust your projection type until the cube appears as 
desired.

Save grid settings as files
Grid settings are saved with the document and may be 
useful if saved as as template for future use: 1) Draw a 
cube in the center of the document for visual reference, 
2) set the grid, and 3) save the file with a useful name. 

When to use Live Objects
Live Objects feature was designed for simple objects or 
choosing projection settings prior to making a detailed 
illustration. Live objects can be cumbersome if you need 
to edit and add faces or details that do not exist on the 
same face “plane.” You should consider creating your 
larger structural faces and objects first as live objects 
to establish the desired view and framework for your 
composition. Then, turn off Create Live Objects and 
create Perspective details without being linked to the 
grid settings. (Live isometric and oblique objects are less 
dramatic but contain parallel receding lines which yield 
more predictable results during updates.)

Using curved paths in Perspective
To create curved paths in perspective, you should 
create normal flat artwork and project it with 
Perspective Objects palette for best results. 

When in doubt...copy or save
Consider copying and pasting your flat artwork prior 
to projecting it – at least until you have finished the 
project. Or save a copy of your flattened artwork before 
projecting.

Perspective drawing tips

Finding centers of objects in perspective
Projected faces in perspective do not show true centers. To find 
the center, create diagonal lines between the corners of the 
face.

Round join stroke settings for Perspective artwork
The geometry of projection may naturally cause many sharp 
angles in the artwork. If you plan to stroke the artwork, you 
may want to use Round Join for a cleaner appearance. You can 
choose Round Join in the Options panel of the Illustrator Stroke 
palette.

Avoid using gradient mesh tools on live objects
A Perspective “live” object is automatically expanded  and no 
longer linked to the Perspective grid if an Illustrator gradient 
mesh tool is used on the object. Use gradient meshes by apply-
ing them to flat artwork and then projecting.

Perspective line tool for guides
The Perspective line tool can be very helpful in making quick 
guides while drawing. Guides can also help you accurately place 
a series of receding objects.

Accurately moving Perspective artwork
It may be difficult to accurately position live Perspective 
artwork, since all lines update to match the grid. However, 
one “home point” remains stationary (see page 37). Drag this 
point to a desired location for best results.

Using multiple views on the same document
You can easily create illustrations with different projections 
as long as you expand any live Perspective artwork before 
changing your projection settings. You may want to uncheck 
Create Live Objects if you plan to often change projection 
settings during your project.

construct diagonals between 
the corners to find the true 
center of a perspective face
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Perspective rendering tips

Using gradients with Perspective

You can use gradient fills to simulate lighting of objects. 
Remember that contrast between light and dark faces 
provides a better illusion of depth. 
For cylinders: 1) Select a face and drag the gradient 
tool across the face in a direction perpendicular to the 
receding lines. 2) Modify the gradient using the gradient 
palette so that you have a light color stop that corre-
sponds to the light direction and a dark color stop for 
the shadowed surface. 3) Modify the gradient palette so 
that you have a lighter color under the darkest band at 
the bottom of the cylinder that corresponds to bounced 
ground light.
For cubes: 1) Select the front or side face and drag a 
gradient diagonally across the surface. Bounced ground 
light often causes a face to appear lighter toward the 
bottom of the cube. Use a diagonal or horizontal gradient 
for the adjacent face. Create contrast between colors along 
the front edge 2) For the top brightest face, vertically 
drag a gradient light in color. To maintain edge definition, 
darken the blend toward the back corner of the cube.

Using patterns with Perspective
Patterns are not automatically transformed with 
Perspective objects, but you can force a transformation of 
pattern artwork by expanding and projecting it with your 
flat artwork: 1) Fill the flat artwork with a desired pat-
tern. 2) Select the artwork and expand using Illustrator’s 
Object > Expand... 3) Then project the expanded 
artwork with the Perspective Objects palette.

drag gradient fill tool 
perpendicular to 
receding lines

lightest value

lighter value
from bounced
ground light

use lighter values
for the gradient
on the face

drag gradient fill 
vertically on top
 surfaces

drag gradient fill 
diagonally on front
and side surfaces

darkest value


